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1 Introduction

CardOS API improves the traditional public-key PKI technology process because the user can use CardOS smart card technology to:

· Store private keys, certificates and private data in a temper-resistant storage 
· Perform secure and critical operations as digital signatures, key generation and key exchange, separated from other parts of the system.

· Guarantee the portability of credentials (key couple and relative certificate) and other private information between computers at work, at home or anywhere. 

Before starting to use CardOS API, however, you should have already installed the CardOS API product on your personal computer SW environment. Refer to [R1] in order to perform this task.

1.1 Purpose

This manual is intended to help the user to configure CardOS API in a Microsoft environment and 3rd party applications. CardOS API includes cryptographic modules, SI_PKCS11 and SI_CSP, to use CardOS smart cards.

The SI_PKCS11 module is an implementation of the PKCS#11 standard, version 2.10. PKCS#11, also called “Cryptoki”, based on cryptographic standard defined by RSA Laboratories. The SI_PKCS11 module is used in the context of this manual in Netscape environments.

The SI_CSP module is an implementation of the Microsoft CSP standard (Smart Card Cryptographic Server Provider Notes, version 1.4.2, released March 17, 2000 by Windows NT Design Team – Doug Barlow © Copyright Microsoft Corporation). The SI_CSP module is used in Microsoft environments.

Developers can use both SI_PKCS11 and SI_CSP,for details refer to [R4].
This guide describes:

· how to integrate SI_PKCS11 and SI_CSP, in general CardOS API, in Netscape products (Navigator and Messenger) and in Microsoft products (Internet Explorer and Outlook). 

· how to download and install certificates from a CA.

· how to send signed and/or encrypted mails.

· how to use all the features of Microsoft operating systems.

Siemens Informatica is not responsible for any threats to your network and/or computers that come with the configurations explained in this manual. The configurations suggested are intended only for test or evaluation purposes and have to be adjusted to your security needs.
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 Attention: The reader of this Manual should be familiar with Security Concepts in general (PKI, Certificates, Digital Signature, etc.) and Microsoft Security Concepts in particular.


The screenshots in this Manual are taken from Windows 2000 environments. Other operating system environments may differ in the look and feel. 
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 Note: Information in this document is subject to change without notice and does not represent an obligation on the part of Siemens Informatica.

All names of companies and products mentioned herein are part of an invented situation and are intended only to document the installation and use of CardOS API product. All or part of these names might be trademarks belonging to their respective owners.


2 Smart cards to be used with CardOS API

CardOS API supports CardOS M4.00, CardOS M4.01, CardOS M4.01a and CardOS M4.20 smart cards and USB tokens (For supported devices see [R3] too.)

A new (blank) smart card needs to be initialised before it can be used with the CardOS API. During the initialisation process a new file structure is created on a blank CardOS card. This manual assumes that you have already received an initialised CardOS smart card that supports all the 3rd party applications’ functionality described in this manual. Regarding how to receive your initialised smart card please refer to your Security System Administrator. 

To support applications that are not described in this manual a different initialisation process may be required (please refer to your Security System Administrator).
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 Note: Your System administrator should have received CardOS Assist Documentation for information about smart card initialisation. The CardOS Assist tool, documentation and Initialisation scripts (csf files) are bundled and delivered together with CardOS API by your smart card supplier.


2.1 Safe handling of smart cards

Some smart card readers allow the manual removal of the inserted smart card during write operations. This may corrupt your smart card. To prevent this CardOS API provides a Safety procedure to handle your smart card in a save way, thus avoiding damages to your smart card. 

If the smart card is incidentally extracted in preparation for use, there will appear a message window (see Figure 1) on the screen.
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Figure 1 Message window on extraction of smart card during write operation.

At this point re-insert your smart card in the reader and then click on the OK button.

If the smart card is incidentally extracted while being used, there will appear a message window (see Figure 2) on the screen.
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Figure 2 Message window on extraction of smart card during write operation.

At this point re-insert your smart card in the reader and then click on the Retry button. If you select Retry but the smart card is not present in the smart card reader, an other message window appears (see Figure 3).
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Figure 3 Message window that appears if the smart card is not in reader.

The last message window appears if you have inserted a different smart card and if you have pressed the Retry button (see Figure below).
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Figure 4 Information message displayed if you insert a different smart card.

In case your smart card becomes unreadable, you can only re-initialise your smart card (please refer to your Security System Administrator or to your CardOS smart card provider).

3 Configuring Windows smart card login

Interactive logon is the capability to authenticate a user to a network, using credentials such as a hashed password. Windows 2000 and Windows XP support public-key interactive logon, using a X.509 version 3 certificate stored on a smart card with the relative private key. Instead of providing username and password to the Graphical Identification and Authentication (GINA), the user enters his Personal Identification Number (PIN), which authenticates the user to his CardOS smart card. The smart card logon consists of three phases: 

· certificate reading from the smart card, 

· check of certificate validity (if it is issued by a trusted CA) and 

· authentication process, during which is verified if a private key corresponding to the public key in the certificate resides on the smart card. 

This chapter describes how to configure smart card interactive logon.

Smart card logons for other Microsoft operating systems are out of scope of this document. 
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 Note: The presence and use of a Microsoft Certification Authority, configured with a company policy module, is recommended for the Windows 2000 logon. 

For the use of other CA’s, please consult the Microsoft documentation under www.microsoft.com 


Main steps required to set up and use this service are:

	Step 1
	Configure a Microsoft Certification Authority (CA) compliant to a company-wide policy module.

	Step 2
	Specify a policy to release (or not to release) certificates to each user

	Step 3 and 4
	Configure one account to be used as enrollment agent

	Step 5
	Request (and download) smart card logon certificates for the users


Step 1 and Step 2 are typical tasks for the domain and CA administrator, given that the CA resides on a central server (in this case system administrator access rights are required). These steps are included in this manual for completeness.

Therefore an end user can usually skip Step 1 and Step 2.

3.1 Step 1 – Configuring the CA

In order to configure the Certification Authority to emit certificates valid for smart card login, follow these steps (on the CA platform console):

From the Start menu, select Run and input mmc in the text box; then click OK. The Microsoft Management Console will open on the desktop.
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Figure 5 Adding certificate services using the Microsoft Management Console

From the Microsoft Management menu, click on Console and select Add/Remove Snap-in. The “Add/Remove Snap-in” window will open.

Click on the Add button to open the “Add Standalone Snap-in” window. In the list of the available snap-in services, select Certification Authority, click on Add, then click on Close to close the “Add Standalone Snap-in” window and go back to the “Add/Remove Snap-in” window. Finally click OK to save the changes.

Expand the “Certification Authority” node and the “domain name” node (the domain name in this example is “Security Product”).
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Figure 6 Selecting new certificates templates

To show all the certificate templates available for that CA, select “Policy Settings”. If the list does not contain the items “SmartCardLogon”, “Enrollment Agent” and “MachineEnrollmentAgent”, click on the mouse right button, and select New->Certificate to Issue. All the supported templates will be listed. You should select the above 3 templates and add them to the list in the Policy Settings Window by clicking OK.

3.2 Step 2 – Specify the CA Enrollment Policy

The Certification Authority issues certificates using templates registered in the Active Directory. However not all users can obtain a certificate from the CA. A configuration activity is necessary before proceeding further, in which we have to specify the enrollment policy.

In order to configure the enrollment policy, follow the steps listed below

1. From the Start menu, select Run and input mmc in the text box; then click OK. The Microsoft Management Console will open on the desktop (see below).

2. From the Microsoft Management menu, click on Console and select Add/Remove Snap-in. The “Add/Remove Snap-in” window will open.

3. In this window, click on the Add button to open the “Add Standalone Snap-in” window. In the list of the available snap-in services, select both Active Directory Sites and Services.

4. If the Services node is not visible, select Show Services Node from the View menu. Then expand the Services node, the Public Key Services node and click on Certificate Template (see below).
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Figure 7 Assigning enroll permissions to users

5. Select one of SmartcardUser or SmartcardLogon, click the right mouse button and select Properties. The “SmartCardLogon Properties” window will open.

6. On the “SmartCardLogon Properties” window, select the Security tab, and then click on Add. From the user window, select the user or the group that should receive enrollment agent certificates, and assign to them the Read and Enroll permissions.

7. Select the MachineEnrollmentAgent template (see Figure below), right click the mouse and select Properties.
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Figure 8 Configuring the enrollment policy

8. On the Security tab, add the computer or the group that should receive enrollment agent certificates and assign to them the Read and Enroll permissions.

3.3 Step 3 – Download the CA certificate

To download the Certification Authority (CA) please follows these steps:

1. Run MS Internet Explorer and open http://CAServer/certsrv, where CAServer stands for the name of the server where the CA is installed.

2. Select Retrieve the CA certificate or certificate revocation list, then click Next. A web page similar to the one below appears.
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Figure 9 Retrieving the CA certificate

3. Click on Install this CA certification path (this way your computer recognizes the valid CA certificates).

4. Click on Download CA certificate and open the certificate.
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Figure 10 Install certificate

5. Click on Install certificate bottom.

6. Click Next in “Welcome to the Certificate Import Wizard” window.

[image: image15.jpg]Certificate Import Wizard

Certificate Store
Cartificate stores are systam arsas whers certificatss ars kept.

Windaws can autnmatically ssiect 5 certificats store, or you can specify 3 location

 Automatically select the c

tificate store based o e type of certificats
£ Place all certificates In the following store.

Certificate store:

Browse,

<o e





Figure 11 Certificate Store

7. Select Place all certificate in the following store in “Certificate Import Wizard” window.
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Figure 12 Show physical stores

8. Tick on Show Physical stores in “Select Certificate Store” window
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Figure 13 Select certificate store

9. Expand Trusted Root Certification Authority node and select Local Computer as shown in 
in the figure above and then click OK
10. Click Next in “Certificate Import Wizard” window

11. Click Finish bottom in Completing Certificate Wizard window and confirm the successful import of the certificate.

3.4 Step 4 – Configure the Enrollment Agent Account

In order to request Smartcard logon certificates, the user must have an Enrollment Agent certificate. When a user has such a certificate, he can submit a request for a Smartcard logon certificate for his own use or for other users.

Do the following to obtain a Smartcard Enrollment Agent certificate (see the figure below):

1. Using MS Internet Explorer, go to http://CAServer/certsrv (where CAServer is the name of the server where the CA is installed).

2. On the Welcome page, click on Request a certificate, and then click on Next.

3. Select Advanced request, and then click on Next.

4. Select Submit a certificate request to this CA using a form, and then click Next.

A web page is then displayed listing the attributes of the certificate to be emitted. Do the following:

1. From the Certificate Template combo box, select Enrollment Agent.

2. Select Microsoft Enhanced Cryptographic Provider as CSP

3. Set the key length to 1024 bit.

4. Leave unchanged all the other settings

5. Click on Submit.

This certificate will not be kept on the smart card, because it has to reside on the computer from where the smart card logon certificates are requested (Registration Authority).
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Figure 14 Obtaining the Enrollment Agent certificate

3.5 Step 5 – Requesting a Smart Card Logon certificate for a user

After having configured the CA, the enrollment policy and the enrollment agent, new smart card logon certificates can be requested as described in the following steps:

Run MS Internet Explorer and go to http://CAServer/certsrv (where CAServer is the name of the server where the CA is installed).

1. Insert your smart card into the reader
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 Warning: To complete the configuration it is mandatory that an initialised smart card is inserted into the reader. Besides, it is strongly recommended that the smart card is not removed from the reader during the configuration process. (See Safe handling of smart cards) 


2. On the Welcome page, click on Request a certificate, and then click on Next.

3. Select Advanced request, then click Next.

4. Select Request a certificate for a smart card on behalf of another user using the Smart Card Enrollment Station, then click on Next. The Smart Card Enrollment Station window will open.

5. As Certificate Template, choose Smart Card Logon

6. As Cryptographic Service Provider, choose SI CSP
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Figure 15 Requesting a smart card logon certificate for a user

7. As Administrator Signing Certificate, select the Enrollment Agent certificate (see Figure above).

8. Fill the text box under User To Enroll with the user to whom the certificate has to be released.

9. Click Enroll.
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Figure 16 Selecting a user to enroll

The smart card logon certificate for the selected user will now be downloaded in the smart card.

Then it is possible to access your workstation using your smart card. 

4 Automatic certificate propagation/removal

CardOS API automatically propagates the certificates stored on a smart card to the system. 

If a Siemens smart card (as CardOS M4.00, CardOS M4.01, CardOS M4.01A and CardOS M4.20) is introduced to one of the readers installed and present in the system, CardOS API scans all certificates in the smart card and introduces them to the Microsoft certificate store (the API read and stores certificate in the “Personal” Microsoft store; if the certificate, found in the smart card, is a Certification Authority or sub Certification Authority certificate, the API store that in “root certification authority” without ask to the user if you want trust that). If the certificate on the smart card has imported in the token like “private”, user pin is requested.. Automatic certificate Propagation/Removal is visualized by an icon on the Microsoft Task Bar, this icon is animate during the process of certificate propagation. In this way the user knows when the process of propagation is finished. This feature enables the user to use certificates present in his smart card to sign, to decrypt mails and to do SSL Authentication, using Microsoft Browser (IE), Microsoft Outlook Express, Microsoft Outlook 2000 and all Microsoft products which use a smart card CSP. 

When a smart card is removed, automatically its certificates, previously introduced in the Microsoft certificates store, are removed from it (the API remove from “Personal” certificate store the certificate that has before imported).
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 WARNING: If the smart card is present a certificate without correspondent private key automatic propagation failed (if the certificate is Certification Authority or sub Certification Authority Certificate the propagation works properly), the same problem happens when CKA_LABEL and CKA_ID of certificate and private key are different.


.

This utility includes also a menu, visible after right-click on icon 
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 on Task Bar (Figure below)
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Figure 17 Automatic propagation menu

4.1 PIN PUK Management

Periodically, the user should change the PIN of his smart card to be sure that unauthorized persons cannot use it. The PIN PUK Manager provides two options for this: Change User PIN and Change PUK in PIN and PUK menu. Smart card management is also intended to calculate the free space (public and private) on the smart card.
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 Note: Smart card management is at disposal on menu Start->Programs->Siemens Informatica->PinManger, too.


4.1.1 Smart Card

The Smart Card menu offers the possibility to open the smart card in the reader and to visualize information about the memory space, free and occupied, on the smart card inserted.

After selection of Open on the Smart Card menu a connection with the smart card in the reader is established and the following information are visualized:

· Smart card label:

· Manufacturer 

· Card Operating

· Serial Number

· Minimum Pin length

· Maximum Pin length

· Total public memory

· Free public memory

· Total private memory

· Free private memory

· Number of public objects
4.1.2 Pin/Puk menu

Selecting PIN menu the user can verify and change the smart card PIN and PUK.

4.1.3 Help menu

Using the Help menu the user can control the version of the modules, of CardOS API, installed on his workstation and the version of PinManager. API Information presents a table showing all CardOS API modules present on the workstation and their version. If not all of the modules are installed or if they are installed in a wrong directory the message “NOT ALL THE API MODULES ARE PLACED IN THE CORRECT POSITION. THIS MAY CAUSE A MALFUCTION OF THE API!” appears. If this message is displayed re-install CardOS API or contact your system administrator.

4.2 ShowcertificateList

Show certificate list is a utility to visualize the certificates that reside on the smart card(s) present on the machine. The list shows the certificate name, which is the common name of the subject certificate (see Figure 18). The Certificate list window also displays the name of the smart card reader as it is installed in the registry.
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Figure 18 Certificate List

By selecting the certificate and clicking view certificate (see Figure 19) the user visualizes the content of the certificate. The Certificate Viewer window displays all attributes and information about the selected certificate.
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Figure 19 View of certificate data

If a certificate on the smart card could not be inserted in the Microsoft certificate store, the certificate is marked with [image: image28.jpg]


 as shown in Figure 20
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Figure 20 Certificate not propagated

If a certificate that resides on the smart card is a CA certificate, then the certificate is marked with the icon 
[image: image30.png]


.

4.3 About

The user can see the version of CardOS API installed on his workstation.
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 Note: Automatic certificate propagation is a new feature of CardOS API version 2.4.0, before this version the user propagates the certificates in smart cards through SICardIntro.exe. 


4.4 CA certificates

If a smart card contains CA certificates, automatic certificate propagation introduces them to their appropriate certificate store (CA or ROOT store). Certificates of either type are not automatically removed when the smart card is extracted.

5 Configuring Netscape for smart card use

This chapter describes how to load the CardOS API cryptographic module into Netscape products in order to use CardOS smart cards. 

Before starting to configure Netscape Navigator and/or Netscape Messenger make sure that 

· your smart card reader is installed (please refer to CardOS API Installation Guide for details) and 

· the smart card is initialised (see Smart cards to be used with CardOS API). 
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 Attention: This section describes how to integrate CardOS API in Netscape 4.7x, for versions newer than 4.7x see Netscape Manual.


The following steps apply to any supported Operating System.
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 Note: The pictures displayed in the following figures can contain text different from what you will see on your screen.


5.1 Netscape Navigator configuration

To configure your Netscape Navigator, follow these steps.

1. Insert the Smart Card into the reader.
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 Warning: To complete the configuration it is mandatory that an initialized smart card is inserted into the reader. Besides, it is strongly recommended that the smart card is not removed from the reader during the configuration process. (See Safe handling of smart cards) 


2. Run the Netscape Browser and click on the “Security” button in the tool-bar.

3. Select “Cryptographic Modules”. The figure below shows what should appear on the screen:

[image: image35.jpg]



Figure 21 Selection of Cryptographic Module

4. Click the “Add” button on the “Cryptographic Modules” window (see previous figure). The figure below shows what should now appear on the screen:

[image: image36.jpg]



Figure 22 Adding Security module.

5. Insert in the “Security module name” edit box the text “Siemens CardOS API” and in the “Security module file” edit box “SI_PKCS11.dll”.

6. Click “OK”. Netscape tries to communicate with SI_PKCS11 library; if it it is found you will be prompted to insert your PIN.

If a wrong PIN is inserted for more than 3 times, the card is blocked and the installation procedure cannot proceed.
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 Warning: If the PIN request is not displayed after a while; this could mean that the smart card is not correctly inserted into the reader. In this case, if the module “Siemens CardOS API” has been already added in the Cryptographic Modules list box, you have to select and delete it from the list (using the Delete button on the right of the list). Then close Netscape and repeat the configuration process beginning with step 1 (be sure that now the card is correctly inserted into the reader; particularly, check the chip side with respect to the reader slot and press on the card edge to verify that it is completely inserted).


7. Click “OK”. You should now see the module “Siemens CardOS API” added in the Cryptographic Modules list box.

8. Select “Siemens CardOS API” in the Cryptographic Modules list box and click the “View/Edit” button. The “Edit Security Module” window opens.
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Figure 23 Edit Security Module Name.

9. In the “Edit security Module” list box, select the module (“CardOS API…”) that you want to verify and click the “More Info…” button. An information window should open, so you can view more details. If the window opens correctly, then the communication between the CardOS API module and the smart card is established in the right way.

10. Return to the “Edit security Module” window; in the list box select again the module (“CardOS API …”) that you want to configure and click the “Config” button. A “Configure Slot” window will open, where you have to set the correct parameters (see figure below). In particular, you have to enable the token and leave disabled all the other check boxes.
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Figure 24 Configure Slot window.

11. Close the “Edit security Module” window. In the list box of the “Cryptographic Modules” window select “Netscape internal PKCS#11 module”. Click the “View/Edit” button; the “Edit Security Module” window will open again. In the list box, select “Communicator Generic Crypto…” and click the “Config” button. 

12. In the “Configure Slot” window select the items as in the Figure 25and click OK.
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Figure 25 Selection of items to enable Netscape functionality.

13. Again, from the “Edit Security Module” window, select the “Communicator Certificate DB” entry in the edit box and click the “Config” button. In the “Configure Slot” window, select the items as showed below.
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Figure 26 Configuration of Netscape internal PKCS#11.

The installation is now complete. Now you can personalise your Smart Card: generating key pairs, requesting and downloading certificates from a Certification Authority (CA).

5.2 Netscape Messenger configuration

Netscape Messenger shares Netscape Navigator’s Cryptographic Module (see Netscape Navigator configuration). For this reason, you do not need to configure it again.

6 Configuration and Usage of SSL Client Authentication

Client authentication involves identification and validation of a client to a server to establish a secure channel of communication. CardOS API can be used to do smart card client authentication using, as secure protocol, “Secure Sockets Layer”(SSL). This section describes how to configure Netscape and Microsoft Internet Explorer using CardOS smart cards. 

6.1 Netscape Communicator

When a secure site (https://<name server>) requests client authentication, you may use the certificate on your smart card to present your credentials to the server, and the private key to prove them.
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 Note: If you haven’t yet configured the Netscape Cryptographic Module please consult “Netscape Navigator configuration”( Netscape Navigator configuration).


6.1.1 Viewing Available Certificates

The Netscape browser allows you to visualize the certificates contained on the inserted smart card. This section describes how to use Netscape for this purpose.

Insert your smart card into the reader

	[image: image43.png]


 Warning: To complete the configuration it is mandatory that an initialised smart card is inserted into the reader. Besides, it is strongly recommended that the smart card is not removed from the reader during the configuration process. (See Safe handling of smart cards) 


Select Security, and click on the Certificates->Yours option to display your available certificates. You will see underlined (in red) the Common Name of the owner of the certificate.
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6.1.2 SSL Client Authentication

Insert your smart card into the reader
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 Warning: To complete the configuration it is mandatory that an initialised smart card is inserted into the reader. Besides, it is strongly recommended that the smart card is not removed from the reader during the configuration process. (See Safe handling of smart cards) 


During a SSL negotiation, one or two steps are possible. The first step, server authentication, is always present. The second step, client authentication, is used only if the server requires it. Only in this second case you will have to provide your PIN and use the private key on the smart card.

If this happens, then you will be prompted for your PIN code. After this the following dialog box will be displayed. Choose one of the available certificates. If more than one certificate is present on the list, be sure to select a certificate of the appropriate type
.
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 Note: when you connect to a secure site, certified by a certification authority still unknown to Netscape, it asks to you to install the new CA certificate in the “trusted certificate list”.


Click now on Continue to establish the connection.

6.1.3 Import PKCS#12 format file in smart card

PKCS#12 format file is a file containing a certificate and its relative private key. To insert in your smart card a PKCS#12 format file using CardOS API follow these steps:

1. Insert your smart card into the reader 
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 Warning: To complete the configuration it is mandatory that an initialised smart card is inserted into the reader. Besides, it is strongly recommended that the smart card is not removed from the reader during the configuration process. (See Safe handling of smart cards) 


2. Click on Security button in Netscape browser window

3. Click on Your certificate  

4. Click on Import a certificate… button  (see Figure 27)

5. A file selection window appears. Select your PKCS#12 format file
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Figure 27 Import of PKCS#12 format file in smart card

If the operation is successfully terminated appears a window similar to the window in Figure 28.
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Figure 28 Message for successful importation of PKCS#12 format file in smart card

6.2 Internet Explorer

You may use CardOS API in SSL negotiations using your Internet Explorer browser. When a secure site (https://……) requests client authentication, you may use the certificate on your smart card to present your credentials to the server, and the private key to prove them.

6.2.1 Viewing Available Certificates

Select from the Menu bar of Internet Explorer Tools -> Internet Options. Then select the tab Content and click on Certificates button
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6.2.2 SSL Client Authentication

In order to use the SSL Client Authentication protocol with Internet Explorer, follow these steps:

1. Start Microsoft Internet Explorer.

2. Insert into the address bar the URL “https://<server-name>”, where “<server-name>” is the web site requesting the SSL client authentication.

3. Insert the smart card into the reader
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 Warning: To complete the configuration it is mandatory that an initialised smart card is inserted into the reader. Besides, it is strongly recommended that the smart card is not removed from the reader during the configuration process. (See Safe handling of smart cards) 


4. During the handshake a Client Authentication window is prompted. Select the SSL Authentication certificate you want to use. In Figure 29, “SSL Authentication certificate” is just a fantasy name, not the name you will see.
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 Note: Client Authentication window appears only if more than one SSL Authentication certificate is registered into your system.


5. Insert your Smart Card PIN

6. If the web site server accepts your certificate, you can enter the requested page (Figure 30).
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Figure 29 Client Authentication Window of Internet Explorer
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Figure 30 Successful SSL Client Authentication

7 Configuration and Usage of Mail Client

Secure e-mail allows users to exchange data or documents confidentially and to trust their integrity. To do this the user can select one of the valid certificates stored on his smart card to sign and to decrypt secure messages using the smart card engine. Certificate are seen as valid if they have been issued by a trusted CA. CardOS API adds a level of security to e-mail applications, such as Microsoft and Netscape, in fact it stores the private key on the CardOS smart card, protected by a PIN. The security is granted because to spoil the private key and send signed e-mail as someone else, one has to obtain both the user's smart card and PIN. This chapter describes how to configure Outlook and Netscape Messenger to be used as secure email clients. 

7.1 Netscape Messenger

Netscape Messenger uses the PKCS#11 interface of CardOS API (SI_PKCS11) to send and receive signed and/or encrypted mail.

If your Netscape browser has been already configured, no further configuration is necessary. Otherwise refer to “Netscape Navigator Configuration” (see Netscape Navigator configuration)

However, if the CA certificate is unknown to Netscape, you need to add the CA certificate in the Netscape trusted certificate list.
For all the following steps it is necessary to insert the smart card into the reader.
7.1.1 Sending a signed message

Before you can send a signed mail message, you have to select a certificate. Select Communicator->Tools->Security Info from the menu and click on the Messenger option in the dialog box.
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 Note: Before any operation, verify that your smart card is inserted in your smart card reader.
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Figure - 1. Selection of certificate to sign/encrypt a mail

Select in the list box the certificate that you want to use to sign/encrypt the messages and click OK.
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 Warning: Select a certificate with the same email address that you’re using in Netscape messenger, otherwise an error will occur when trying to send an e-mail (see Figure - 2).
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Figure - 2. Error when you select a certificate that has a different email address

You can now start to compose your first “signed” message. 

Click New Message and go in Security Info. Specify that the mail is to be signed by selecting “Include my Security Certificate in this message and use a digital signature to sign this message” .

Click OK.
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 Note: To select the security action In Messenger 4.76, you can use the tab Message Sending Options in the addressing area (see figure below)
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When you finished editing your message, insert into the “to” field your email address (this is the first test to do) and click the Send button. The Password Entry dialog box will appear. Enter the PIN code and click OK. Your signed mail is now on its way!

7.1.2 Receiving a signed message

When you receive a signed mail message in Netscape Messenger, a “Signed” icon on the message will appear (see Figure - 3).
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Figure - 3. Received signed Mail

A click on the “Signed“ icon displays information about the sender of the message (see Figure - 4).
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Figure - 4. Security Information of received signed mail

You may view the certificate of the sender by clicking on the View/Edit button. The sender’s certificate is automatically added to “People’s Certificates”, and from now on you can use it to send encrypted mail to the certificate owner.
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 Note: Messenger does not set any trust on the CA certificate (see also par 9). You should add the trust yourself. Consequently, the signature will be displayed as invalid until you specify trust for the CA certificate.


7.1.3 Sending Encrypted Mail

Compose a new message as usual. If you have the e-mail certificate for the destination e-mail address, you may encrypt the message. If you click the Security Info option, the following dialog box appears (Figure - 5).
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Figure - 5. Information about Encrypted Mail

If you have the certificate of the receiver, you will be able to select “Encrypt this message”. Select this option and your mail will be encrypted before it is sent. Now only you and the receiver are able to read the message.
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 Note: To select the security action in Messenger 4.76, you can use the tab Message Sending Options in the addressing area (see figure below)
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You may have obtained the certificate of the receiver in a previous signed mail from that person. If a certificate for the receiver cannot be found, the message “This message cannot be encrypted when it is sent because <recipient> has no Security Certificate” will appear.

7.1.4 Receiving Encrypted Mail

To open an encrypted mail, you should have the smart card inserted into the reader. You will be prompted for the PIN before the mail can be decrypted and displayed to you (the mail is encrypted with your public key and your private key is needed to decrypt it).
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Figure - 6. Information about signed mail

Click on the “Encrypted” icon in the message. Detailed information on the encryption procedure (see Figure - 6) will be displayed.
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Figure - 7. Information about Encrypted Message

7.1.5 Sending a Signed and Encrypted Mail

You may specify both encryption and signing when sending a mail, simply by selecting both options in the Security Info dialog box.
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 Note: To select the security action In Messenger 4.76, you can use the tab Message Sending Options in the addressing area (see figure below)
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When sending the mail it will be both encrypted and signed. You have to enter your PIN code to sign the mail.

Remember that you need the certificate of the receiver to send him an encrypted mail.

7.2 MS Outlook Express

7.2.1 Sending/receiving singed and/or encrypted messages

To send a S/MIME e-mail message, you have to link your certificate and your e-mail account before.
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 Note: Before any operation, verify that your smart card is inserted in your smart card reader.


7.2.1.1 How to do to link a digital certificate to an e-mail account

1. Click on the Tools menu, and then click Accounts.

2. Select the account you want to use your digital certificate with, and then click Properties. 

3. Click the Security tab (see Figure - 8).
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Figure - 8. Security Tab

4. Select the certificate you want to use for signing and encrypting your mail message (see Figure - 9).
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Figure - 9. Selecting a certificate for signing mail messages
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 Note: The image is relative to Windows 2000. If you have Windows 98 you have to click on Digital ID instead and select the certificate that you want to use.


7.2.2 How to Send a signed e-mail message

Before sending a message, click the Tools menu in the New Message window, and then click Digitally Sign.

– Or – 

Click the Sign message icon on the New Message toolbar (see Figure - 10).
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Figure - 10. Signing a message

Insert your smart card in reader.

Write and send your mail.

Insert your PIN.

7.2.3 Receiving encrypted messages.

Encrypting a message prevents other people from reading it while it is in transit over a network. To encrypt a message, you need to have a digital certificate, and you need to know the digital certificate of the person you are sending the message to. The digital certificate must be part of the person’s entry in the Address Book.

To add a digital certificate to your Address Book from a digitally signed message that you receive:

1. Open the digitally signed message. 

2. On the File menu, click Properties (see Figure - 11).
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Figure - 11. Selecting properties of a signed message

3. On the Properties Window, click the Security tab, and then click View Certificates (Figure - 12).

4. On the View Certificates window, click Add to Address Book.
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Figure - 12. Security Tab
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 Note: These images are referring to a Windows 2000 platform.


To add a digital certificate to your Address Book from another source do the following:

1. In the Address Book, create a new entry for the contact, or double-click an existing contact. 

2. In the Properties dialog box for the contact, click the Digital IDs tab, and then click Import. 

3. Find the digital certificate file, and then click Open.
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 Note: when a contact has a digital certificate, a red ribbon is added to his card in the Address Book.


7.3 MS Outlook 2000

7.3.1 Signing and encrypting messages

To sign and/or encrypt e-mail messages, you have to link your certificate and your e-mail account before.

	[image: image81.png]


 Note: Before any operation, verify that your smart card is inserted in your smart card reader.


7.3.1.1 How to link a digital certificate to an e-mail account

On the Tools menu, click Options and select Security tab (Figure - 13). 
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Figure - 13. Secure e-mail settings

5. If you have already a security setting, select it as the Default Security Setting. If you don’t have a security setting, then you should create a new one clicking on Change Settings… (Fig. 35).

6. Insert in Security Settings Name (Figure - 14) the name chosen for your new security setting. 
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Figure - 14. Changing a security setting

7. Click on Choose to select the Signing Certificate and Encryption Certificate (Figure - 15), then click OK.
[image: image84.jpg]Select Defailt Account Digital 1D E

= 2l

Select the certficate you want t Use.

| tesued by
Terpel

oo | mycunn





Figure - 15. Selecting certificates to be used for e-mail protection

7.3.2 Signing and sending an e-mail message

1. Before sending your message, click Options on the menu in the New Message window (Figure - 16).
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Figure - 16. New message window

2. On the Message Options window (Figure - 17), select Add digital signature to outgoing message
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Figure - 17. Message Options window

3. Write and send your mail;

4. When requested, insert your smart card PIN.

7.3.3 Receiving Encrypted Messages

Encrypting a message prevents other people from reading it while it is in transit over a network. To encrypt a message, you need to have a digital certificate, and you need to know the digital certificate of the person you are sending the message to. The digital certificate must be part of the person’s entry in the Address Book.

To add a digital certificate to your Address Book from a digitally signed message that you received:

1. Open the digitally signed message.

2. Select the e-mail address of the sender, right-click the mouse on it and select Add to contacts.

8 Configuring smart card VPN and smart card RAS connection

VPN connections allow the user to work at home (or at another place) using a remote access connection to an organization server through a network such as the Internet. CardOS API allows users to establish a VPN connection, using credentials stored on the smart card to authenticate himself to the server in question. Using the smart card the integrity and validity of the credentials used by the user are guaranteed. 

RAS connections, in opposition to VPN connections, use the telecommunications infrastructure to do a physical circuit or a virtual circuit to a port on a remote access server. Thanks to CardOS API the user can create a RAS connection using the credentials stored on his CardOS smart card.

This section describes how to configure RAS logon connections and a VPN with smart cards on both the client and server side.
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 Note: Both the client and server must have a certificate from the same CA or a CA in a trusted hierarchy.


8.1 Client configuration

This section explains how to configure the RAS client.

8.1.1 Smart card RAS connection

The smart card RAS connection:

1. Creates a connection between your PC and a Server using your modem.

2. Uses the credentials stored in your smart card to authenticate yourself on the server.

8.1.1.1 Creation of a RAS connection

Following steps:

1. Click on Start->Settings->Network and Dialup Connections.
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Figure - 18. First step.

2. Select Dial-up to private network (see Figure - 19) and click on Next.
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Figure - 19. Selection of network connection type.

3. Insert phone number to dial (see Figure - 20)
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Figure - 20. Phone number to dial

4. Select Use my smart card and click on Next (see Figure - 21).
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Figure - 21. Select my smart card.

5. Select For all users or Only for myself and then click Next(Figure - 22)
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Figure - 22. Enable all users to make this connection.

6. Insert the name that you want to give the connection and click on Finish (Figure - 23)
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Figure - 23. Completing the Network Connection Wizard.

8.1.1.2 Configuration of RAS connection with smart card

Following steps:

1. Click on Start-> Settings->Network and Dialup Connections.

2. Right-click on the connection that you have just created and select Properties
3. Select Security Tab

4. Select Advanced and press on Settings button (see Figure - 24).

[image: image94.jpg]-zl
Gt optans Secury | Nowaans| shana|

Socuyoptione — =
© Typieal ecommended setings)

& Advancad (csiom serins)

Usig ose soligs reuies s KioWS98 0l songs
secunypiciocols (= Somnse ]

Inerectiologon andserping—————
™ Shawtsminsivmdon

L — |

o cancel





Figure - 24. Connection Properties.

5. Select Use Extensible Authentication Protocol (EAP) and select Properties (see Figure - 25).
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Figure - 25. Selection of EAP Protocol.

6. In Smart Card or other Certificates Properties (see Figure - 26):

· Select Use my card
· Tick on Validate Server Certificate
· In Trusted Root Certificate Authority box select the CA that issued the certificate in your smart card

· Click on OK
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Figure - 26. Smart Card or other Certificate Properties

8.1.2 Smart card VPN

The client machine authenticates you through a client certificate, so the client must have a valid certificate to do RAS logon connection (see Certificate enrollment example).

8.1.2.1 Creation of VPN connection

1. Click on Start->Settings->Network and Dialup Connections
2. Click on Make New connection Welcome to the Network Connection Wizard appeared (Figure - 18)

3. On Network Connection Wizard Window select Connect to a private network through the internet (see Figure - 27)
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Figure - 27. Network Connection Type.

7. Select in Automatically dial this initial connection box, the RAS connection configured in Creation of RAS connection (Figure - 28)
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Figure - 28. Select initial connection.

8. Insert the host name or IP address of the VPN server and click Next (Figure - 29).
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Figure - 29. Insert host name or IP address.

9. Select Use my smart card and click on Next (Figure - 21).

10. Select For all users or Only for myself and then click Next.(Figure - 22)

11. Insert the name that you want to give the connection and click on Finish (Figure - 30).
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Figure - 30. Completing the Network Connection Wizard.

8.1.2.2 Configuring VPN with smart card

Following steps:

1. Click on Start-> Settings->Network and Dialup Connections.
2. Right-click on the VPN that you have just created and select Properties
3. Select Security Tab

4. Select Advanced and press on Settings button (see Figure - 24).

5. Select Use Extensible Authentication Protocol (EAP) and select Properties (see Figure - 25).

6. In Smart Card or other Certificates Properties (see Figure - 26):

· Select Use my card
· Tick on Validate Server Certificate
· In Trusted Root Certificate Authority box select the CA that iussed the certificate in your smart card

· Click on OK
8.2 Server Configuration

8.2.1 Configuring Routing and Remote Access to accept EAP authentication

Following steps:

1. Click on Start->Run and type mmc
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Figure - 31. Select Add/Remove Snap-in

2. Select Console-> Add/Remove Snap-in (see Figure - 31)

3. Click Add and Select Routing and Remote Access in Add Standalone Snap-in
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Figure - 32. Select Routing and Remote Access

4. Right-click on the server and select Properties (see Figure - 34)
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Figure - 33. Select Server Properties.

5. Click in Security tab Authentication Methods button (see Figure - 35)
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Figure - 34. Select Authentication Methods

6. Tick on Extensible Authentication Protocol (EAP) (see Figure - 36)
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Figure - 35. Select EAP Protocol

7. Click on OK
8.2.2 Enabling EAP in Remote Access Policies

Follwing steps:

1. Follow 1. 2. 3. Steps of 9.2.1

2. Select Remote Access Policies, right-click on remote connection and select Properties (see Figure - 38)
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Figure - 36. Remote connection policies

3. In Properties windows select Edit Profile…(see Figure - 39).
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Figure - 37. Remote connection properties

4. Tick on Extensible Authentication Protocol (EAP) and select Smart Card or other Certificate (see Figure - 40).
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Figure - 38. Edit Dial-in Profile.

9 Configuring Citrix with CardOS API
You can integrate CardOS API in Critrix MetaFrame XPe Release 2 SP2.

This section explains how to configure CardOS API on Citrix Server and on Citrix Client. 

9.1 System requirement
Server: 

See Citrix Documentation.

Client: 

See Citrix Documentation.

Smart Card Readers:

See “CardOS_API_v240_Release_Notes.doc”.

9.2 How to configure Citrix on Server

9.2.1 Key registry configuration

9.2.1.1 CardOS API registry key

Using the tool SIRegMan.exe, select Citrix TS Support to enable CardOS API using Citrix, as shown in Figure 71.
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Figure - 39. Enabling Citrix Support

9.2.1.2 Citrix registry key

You may need to set the following registry key:

HKLM\Software\Citrix\CtxHook\AppInit_DLLs\Smart Card Hook\SpecialDllSearch

Adding the values SI_csp.dll apiscom.dll; SI_csp.dll scarddlg.dll; as shown Figure 72.
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Figure - 40. SpecialDllSearch registry key.

To enable Netscape add the value “SI_pkcs11.dll apiscom.dll;” too.

9.2.2 Enabling CardOS API tools in Citrix Environment

For performance reasons, Citrix MetaFrame by default intercepts smartcard logon only.  It does not by default intercept the application usage of smartcards.  Citrix MetaFrame includes the utility SCCONFIG to configure which applications will use smartcards.

To enable CardOS API tools execute on command prompt line:

· SCCONFIG /LOGON: ON

· SCCONFIG /ENABLE_PROCESS : CardIntro.exe

· SCCONFIG /ENABLE_PROCESS : SCMon.exe

· SCCONFIG /ENABLE_PROCESS : iexplore.exe

· SCCONFIG /ENABLE_PROCESS : PinManager.exe

· SCCONFIG /ENABLE_PROCESS : Netscape.exe

· SCCONFIG /ENABLE_PROCESS : Winlogon.exe

· SCCONFIG /ENABLE_PROCESS : msimn.exe

· SCCONFIG /ENABLE_PROCESS : Netscp.exe

Executing the command line “SCCONFIG /Q” you should have the result as shown in 
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Figure - 41. SCConfig query

9.3 How to configure Citrix on Client

To enable Smart card logon using Citrix Client (ICA Client) right click on ICA Client connection and select “Proprieties”. On “Logon Information” in Properties window, select “Smart Card” option, as shown in Figure below. 
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Figure - 42.  Client configuration

10 Troubleshooting

In case of problems please take a look to section “Known Errors/Limitations of this Version” and “Warnings” in the CardOS API – Release Notes documentation.

Automatic propagation of certificates inserts certificates in the Microsoft certificates store. CardOS API scans all smart card’s certificates and for everyone of them (except CA certificates) the relative private object is searched in the smart card,. A private object is relative to the certificate object if the value of its attribute CKA_LABEL is matching the value of the CKA_LABEL of the private object. This behaviour isn’t compliant to some products, as Entrust, which creates certificates with different attribute CKA_LABEL from relative private object.

To help the user in the case in which CardOS API doesn’t introduce automatically the certificate, even if the registry key is correctly set, the setup process installs also the tool CardIntro.exe.

11 Appendix

11.1 Introduction of Smart Card certificates

Unless a certificate is downloaded on the smart card (with MS IE) and used for authentication on the same workstation, it has to be “introduced” into the system before it can be used by MS IE or MS Outlook. This happens, for example, when a user carries his smart card from his own workstation to another one, or the certificates are generated and downloaded into the card using a different browser (e.g. Netscape). To perform this task, a special tool (CardIntro) has been designed. CardIntro is distributed with the CardOS API SW and is installed by the setup procedure.

In order to use SICardIntro, follow these steps: 

1. Insert your smart card into the reader
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 Warning: To complete the configuration it is mandatory that an initialized smart card is inserted into the reader. Besides, it is strongly recommended that the smart card is not removed from the reader during the configuration process. (See Safe handling of smart cards) 


2. Open the executable on <Install Dir>
 / SI_CSP / SICardIntro.exe (Figure - 45).  
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Figure - 43. SICardIntro main menu

3. Each certificate is associated with a “Container Name”. In order to introduce it to the system accept the ContainerName associated with the certificate you want to introduce by clicking Yes. Clicking on NO skips to the next ContainerName (i.e. certificate) available. In Figure - 46, the name of the ContainerName is exactly “ContainerName”, but normally the name, which will be displayed, is the name you gave to the certificate when it was generated, or a default name assigned by the CA, which issued the certificate.
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 Note: A container name is associated not only with a certificate, but also with the corresponding key couple. If on the smart card a key couple has been generated, but a certificate for that key couple is not (yet) present, then the ContainerName exists, but it cannot be used to introduce the (not existing) certificate. In this case, CardIntro displays a warning message and skips automatically to the next ContainerName available.
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Figure - 44. ContainerName Window

4. Now you should insert the Smart Card PIN in case the certificate was stored as private on your smart card. In case the certificate was stored as public on your smart card this step is skipped.

5. If other certificates are present on the Smart Card, the message of Figure - 46 appears again. If no other ContainerNames (certificates) are available, the message of Figure - 47 is displayed.
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Figure - 45. CardIntro exit message

12 LICENSE ISSUES
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). For this reason, CardOS API stays under a dual license, i.e. both the CardOS API license and the original SSLeay license.

See below for the original SSLeay License.

Original SSLeay License

/* Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)

 * All rights reserved.

 *

 * This package is an SSL implementation written

 * by Eric Young (eay@cryptsoft.com).

 * The implementation was written so as to conform with Netscape’s SSL.

 * 

 * This library is free for commercial and non-commercial use as long as

 * the following conditions are aheared to.  The following conditions

 * apply to all code found in this distribution, be it the RC4, RSA,

 * lhash, DES, etc., code; not just the SSL code.  The SSL documentation

 * included with this distribution is covered by the same copyright terms

 * except that the holder is Tim Hudson (tjh@cryptsoft.com).

 * 

 * Copyright remains Eric Young's, and as such any Copyright notices in

 * the code are not to be removed.

 * If this package is used in a product, Eric Young should be given attribution

 * as the author of the parts of the library used.

 * This can be in the form of a textual message at program startup or

 * in documentation (online or textual) provided with the package.

 * 

 * Redistribution and use in source and binary forms, with or without

 * modification, are permitted provided that the following conditions

 * are met:

 * 1. Redistributions of source code must retain the copyright

 *    notice, this list of conditions and the following disclaimer.

 * 2. Redistributions in binary form must reproduce the above copyright

 *    notice, this list of conditions and the following disclaimer in the

 *    documentation and/or other materials provided with the distribution.

 * 3. All advertising materials mentioning features or use of this software

 *    must display the following acknowledgement:

 *    "This product includes cryptographic software written by

 *     Eric Young (eay@cryptsoft.com)"

 *    The word 'cryptographic' can be left out if the routines from the library

 *    being used are not cryptographic related :-).

 * 4. If you include any Windows specific code (or a derivative thereof) from 

 *    the apps directory (application code) you must include an acknowledgement:

 *    "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

 * 

 * THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND

 * ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

 * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE

 * ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE

 * FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL

 * DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS

 * OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

 * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT

 * LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY

 * OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF

 * SUCH DAMAGE.

 * 

 * The licence and distribution terms for any publically available version or

 * derivative of this code cannot be changed.  i.e. this code cannot simply be

 * copied and put under another distribution licence

 * [including the GNU Public Licence.]

 */

� Different digital certificates exist for different operations: signature, authentication, enciphering, etc. The feature that is used by the applications to understand the type of the certificate is one of their “extensions”, named “key usage”. However, certificates are handled by applications also if they have no extensions, so it may happen that you see more than one certificate on the list. In this case, you should select manually the right one.


� For default Install Dir = <Program Dir> + “Siemens”
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